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	LESSON OBJECTIVES

	

	At the completion of this lesson, students will be able to:

· Create an Access database. 

· Design and use a database form.

· Use queries to display information.

· Generate database reports.



	TARGET AUDIENCE

The target audience for this training includes FEMA Disaster Field Office (DFO) employees, who will need to have an intermediate knowledge level of Access 2000 to complete work assignments at the disaster site.

	

	PREREQUISITES


	· Familiarity with Windows

· A working knowledge of the basic Word 2000 functions

· A working knowledge of the basic Excel 2000 functions

· A thorough understanding of the basic Access 2000 functions



	APPROXIMATE TIME


	3 hours

	CONTENTS


	This lesson includes the following sections:

· Database Fundamentals

· Working with a Datasheet

· Working with Forms

· Working with Reports

· Working with Queries

· Working with Data




	PREPARING

Use the following checklist to help you prepare for this course:



	Supplies and Equipment



	· Computer and monitor for each student

· Computer, monitor, projector, and screen for instructor (the computer should be connected to the projector prior to training)

Handout Materials

· Microsoft Office User’s Guide

· Microsoft Access:  Hands-On Practice–Student Instructions 



	NUMBER OF INSTRUCTORS


	One or two instructors may be used to teach this course.  The instructor:student ratio should be no more than 1:8.



	INSTRUCTOR QUALIFICATIONS


	Instructors must have computer training experience and, at a minimum, intermediate knowledge of Microsoft Excel 2000.



	INSTRUCTOR GUIDELINES AND CHECKLIST


	The following guide is an outline that provides the instructor(s) with directions for teaching Intermediate Microsoft Access 2000.  It is important to assess your audience’s knowledge base and present the materials in the manner that best addresses their needs.  Include step-by-step instruction as necessary and, if needed, add more detail to clarify informational points.  As a measure to ensure that all students are learning the same material regardless of instructor experience, be sure to cover all of the topic areas.

This intermediate course will allow you to demonstrate some of the more involved, yet more widely used features of this interactive database.  As you work through the training outline, allow time for the students to practice what they have been taught.  Walk around the room and help students if you see that they are having problems.  Slow down and repeat the steps, if necessary.  Try not to move on to the next topic before you know everyone can perform what was covered.

Be prepared to answer questions or assist students requiring additional instruction during the hands-on practice done after each section.

	


	OVERVIEW
	Review the course objectives with the students:

· Create an Access database. 

· Design and use a database form.

· Use queries to display information.

· Generate database reports.
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Microsoft Office 

User’s Guide 


	Distribute the job aid entitled “Microsoft Office User’s Guide.”  Tell the students that they can refer to the User’s Guide during and after the training.

Explain that the User’s Guide contains many of the more frequently performed functions within the Microsoft Office suite of software packages.  Although the guide can be used for self-study or individual training, it is designed to be a practical desk tool that can assist with many questions that may arise after the training.  

[image: image12.wmf]Hand out a copy of the Microsoft Access:  Hands-On Practice–Student Instructions.  Tell the students that they will be practice the concepts learned at the end of the training.
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	Key Concepts

Use the following information to provide an introduction to the concepts that will be covered during the training:

· Databases provide a simple way to keep track of information.  

· Information is stored in tables.  The tables can be used in multiple ways to analyze and report the data.  

· A database stores related data tables and other data objects, including queries, reports, forms, and macros.  

· Each database object is stored within a single file named <filename.mdb>.

Types of database objects include:

· Table:  A table stores the data in rows and columns.  You can use a table to input, view, and print data.

· Form:  A form allows information to be input and viewed in a user-friendly format.

· Query:  A query will quickly locate and display information based on user-defined criteria.

· Report:  A report compiles the data into an organized format for viewing and printing.




	DATABASE FUNDAMENTALS
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	Instructor Guidelines
Point out the following key points to review the basics of Access.
Microsoft Access allows you to:

· Build a database using multiple tables and queries.

· Work with data within a table or by using a form.

· Query information about data.

· Create a report using a database.

· Create form letters and mailing labels.

· Sort information within tables.

· Write macros to easily manipulate the data within a database.
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	Instructor Checklist

Provide the following steps for creating a relational database.

Step 1:  Determine the purpose of the database.

Preparing and planning is the first step in designing a database.  It is important that you outline the purpose of the database and how you are going to use it.  Before designing the database structure, look at your data and make some decisions regarding the types of information you want from the database.  From that, you can decide how you are going to build the database.  It is a good idea to know what type of reports you'd like to produce using the database.  

Step 2:  Determine the tables you need.

All of the database objects will draw upon the data contained in the tables, so its important to design your tables keeping the following fundamental design principles in mind: 

· A table should not contain duplicate information, and information should not be duplicated between tables.  In this respect, a table in a relational database differs from a table in a flat-file application such as a spreadsheet. 

· Each table should contain information about one subject.




	DATABASE FUNDAMENTALS
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	Instructor Checklist

Step 3:  Determine the table fields. 

Each table contains information about the same subject, and each field in a table contains individual facts about the table's subject.  When sketching out the fields for each table, keep these tips in mind: 

· Relate each field directly to the subject of the table.

· Include all the information you need.

· Store information in its smallest logical parts (for example, First Name and Last Name, rather than Name). 

Step 4:  Identify the primary key.

Tables should include a field or set of fields where information is uniquely identified and stored.  Access allows users to designate this unique field using the primary key.  The primary key designation will uniquely identify each record in a table.  The primary key is used when building relationships to foreign keys in other tables.

Step 5:  Determine the relationships between tables.

A relationship is an association established between common fields (columns) in two or more tables.  A relationship works by matching data in key fields—usually a field with the same name in both tables. 

Step 6:  Refine your design.

After you have built the tables, fields, and relationships you need, look over your outline and determine if there are any gaps.  If you find gaps, change your database design before filling in the data.  At this point, you can test your design and build initial drafts of your forms and reports to make sure they work with the data you expect to use.

Step 7:  Enter data and create other database objects.

After you have refined the database design, including the table structure and other database objects, it is time to enter data.  Based on the way you created your database, you can either enter data directly into the table structure or use a form.  Supplementary database objects can always be added during this step.




	DATABASE FUNDAMENTALS
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	Instructor Checklist

Provide the following database pointers:

· To work with all the objects within a database, use the Database window.  Under objects, click the type of Object you want to work with, from the right side window, choose the specific database object.  Use the New button on the Database window or the create options at the top of the list to create new objects.  Use the Design button on the Database window to modify existing database objects.

· After you have created the table structure, and generated a form, you can work with tables or forms interchangeably.  Tables are sometimes difficult to read because they are displayed in rows and columns.  Using a form makes it easier to input and look at data.  Working with forms is a user option; if you feel comfortable working solely in the table structure there is no need to generate a form.

· When storing your data, create one table for each type of information that you track.  You can then bring the data from multiple tables together in a query, form, report, or data access page, or you can even define relationships between the tables.

· To find and retrieve just the data that meets conditions that you specify, including data from multiple tables, you can create a query.  A query can also update or delete multiple records at the same time, and perform predefined or custom calculations on your data.

· You can analyze your data or present it a certain way in print by creating a report. 



	WORKING WITH A DATASHEET
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	Instructor Guidelines
Point out the following key points to review the basics of Access.
· Database Wizard:  The Database Wizard will automatically create a database and database objects after you define the database structure using a step-by-step process.  

· Tables:  The basic building block of a database in Microsoft Access is the table.  A table is a collection of data about a specific topic.  

· Primary Key:  A primary key is a field or set of fields that uniquely identifies each record stored in the table.  It is important to designate the table’s primary key field because it helps to prevent duplicate records from being entered into the database.
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	Instructor Checklist

Database Wizard

Explain that wizards are on-screen help instructions to aid you in designing your table.  

Provide the steps below for using the Database Wizard.

To create a database using the Database Wizard:

1. When Microsoft Access first starts up, an automatic dialog box prompts you to create a new database or open an existing one.  Select Access Database Wizards, Pages and Projects, and then click OK.  

2. On the Databases tab, double-click the type of database you want to create.

3. Specify a name and location for the database.

4. Click Create to start defining your new database.  

To create a database without using a wizard:

1. When Microsoft Access first starts up, an automatic dialog box prompts you to create a new database or open an existing one.  Select Blank Database, and then click OK. 

2. Or if you have already opened a database or closed the dialog box that displays when Microsoft Access starts up, click New Database [image: image3.bmp] on the toolbar, and then double-click the Blank Database icon on the General tab. 

3. Specify a name and location for the database and click Create. 

4. After you hit create, you will choose how you want to create your table.  




	WORKING WITH A DATASHEET
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	Instructor Checklist

Working With Tables

Point out that a database can contain many tables.  These can be linked together to build relationships or they can be used alone to analyze data.  Stress that the key to successful database building is planning.  Tell the students to ask themselves the following questions:  What data do I need to manage?  What do I need to do with the data?

Provide the key points below for working with tables in a database.

· A table organizes data into columns and rows.  The top row, or header row of a table, identifies the type of data contained within the rows under each column.  

· The data stored in columns are called fields.  A field is simply a piece of information about something or someone.  

· The data stored in rows are called records.  A table holds all the data records and should not hold more than one type of record.  

· Each record in a table contains all the information about a single subject.

· Having data organized is not important when using Access.  With the built-in features Find and Queries, you can view information in any organized format with just the click of a button.
Explain that a table can be created in Design view, which is similar to entering data in a blank datasheet or table—much like adding data to a spreadsheet.  Point out that when the new datasheet is saved, Access evaluates the data entered and automatically creates appropriate field types and formats.  Tell the students that just as in Excel, many formatting changes can be made in the Datasheet view at any time.
To create a new table in Design view:

1. Select the tab labeled Create Table in Design view.

2. Click Open. 

3. Define each of the fields in your table.  Remember, the fields in the table are the columns; these headers will be your column headers.  (Note:  Page 12 in the User’s Guide provides a complete description of the data fields.)

4. After you have defined the fields click the Close button in the top right corner.  

5. You will be prompted to save the table.  Input a table name and click OK.
6. Access asks you if you want to create a primary key.  If you have entered data that can be used to uniquely identify each row in your table, such as part numbers or ID numbers, click No and you can assign the primary key to a unique field.  Otherwise, click Yes.  If you click Yes, an AutoNumber field is set as the primary key.

7. Follow the steps below to designate the primary key.  (Note:  You don't have to define a primary key, but it's usually a good idea.)
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	Instructor Checklist

Primary Key

Explain that an AutoNumber field can be set to enter a sequential number automatically as each record is added to the table.  Designating such a field as the primary key for a table is the simplest way to create a primary key.  Point out that if a primary key is not set before saving a newly created table, Access will ask if you want it to create a primary key.

To define the primary key:

1. Open the table in Design view.  To do this, click on the table you want to open and click Design.

2. Select the field or fields you want to define as the primary key.  To select the field, click on the gray box to the left of the field name—this is referred to as the row selector.

3. To select multiple fields, hold down the CTRL key and then click the row selector for each field.

4. Click the key icon on the toolbar.  Notice that a key appears at the left of the row, showing that the field is designated as the primary key field.




	WORKING WITH FORMS
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	Instructor Guidelines
Provide the following key points for working with forms.
· Forms provide a user-oriented, convenient interface for data input.  Not only will you see the field identifiers, but also the form looks like a paper form, a familiar mode of data entry.  

· AutoForm:  AutoForm will create a form that displays all fields and records in the underlying table or query.  If the record source you select has related tables or queries, the form will also include all the fields and records from those record sources. 

· Form Wizard:  Access Wizard easily creates a form based on the database objects you have built.  You will determine the form options by answering questions when prompted by the Form Wizard.

· Formatting the Form:  You can use the following techniques to customize a form that you created with a wizard or to create a form entirely on your own.  All changes to the design of the form are done in the Design view.  

· Using the Form:  When you open a form, you are opening it so that you can enter data on the form.  You cannot modify the form design when opening the form.
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	Instructor Checklist

AutoForm

Provide the steps below to create a form using AutoForm.

To create a form using AutoForm:

1. From the Database window, click Forms under Objects.

2. Click the New button from the toolbar.

3. In the New Form dialog box, choose one of the following wizards: 

· AutoForm:  Columnar—Each field appears on a separate line with a label to its left.

· AutoForm:  Tabular—The fields in each record appear on one line, with the labels displayed once at the top of the form.

· AutoForm:  Datasheet—The fields in each record appear in row-and-column format, with one record in each row and one field in each column.  The field names appear at the top of each column. 

4. Select the table or query that contains the data you want to base your form on.

5. Click OK. 




	WORKING WITH FORMS
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	Instructor Checklist

Form Wizard

Provide the steps below to create a form using Form Wizard.
To create a form using the wizard:

1. From the Database window, select the Forms tab, choose Create Form by Using Wizard.

2. Click Open.

3. Choose the tables and fields you want to include on the form, click Next.

4. Select the format for the form, then click Next.

· Single-column (Columnar):  Displays the data from each record in a single column on a separate line with the label displayed to the left.  The records are displayed vertically on the page.

· Tabular:  Displays the data in rows and columns from left to right.  Labels appear at the top of each column and each row represents a new record.

· Datasheet:  Displays the data as it appears in the table.

5. Assign a style for the form, then click Next. 

6. Name the form and choose how you want to view it, then click Finish.

· If you choose Open the Form To View or Enter Information, when Finish is clicked the Form window will automatically open for you to start entering data.

· If you choose Modify the Form’s Design, when Finish is clicked the Form Design window will open so you can modify the form design.

Formatting A Form

Provide the steps below for modifying the appearance of a form’s design.

To modify the design of a form:

1. Click on the formatting options contained in the Formatting Toolbar.

2. To change a background, click in the Design view of a form, right-click with the mouse, choose Fill/Back Color, and click on the color you want.

3. To size form controls, click on the control box and drag the sizing handles until the control is the size you want.  To align boxes, select multiple boxes, right-click the mouse button, choose Align, and choose the desired alignment.

4. Change data labels on the form.  To change data labels, double-click directly into a label box and edit the text.
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	Instructor Checklist

Formatting a Form

Headers and Footers

You can add headers and footers to appear on each page of a form.

Provide the steps below for creating headers and footers in a form.

To add or remove a form header and footer or a page header and footer:

1. Open the form in Design view.

2. Click Form Header/Footer or Page Header/Footer on the View Menu. 

3. Key in the text you want to appear.

Predefined Format

You can format a form using predefined formats.

Provide the steps below for using predefined formats for a form.

To format a form by using predefined formats:

1. Open the form in Design view.

2. Do one of the following:  If you want to format the entire form, click the form selector.  If you want to format a particular section, click the section selector.  If you want to format one or more controls, select the controls. 

3. Click AutoFormat [image: image4.bmp] on the toolbar.

4. Click one of the formats in the list and choose any options.

Using a Form

Provide the steps below for using the form.

To open a form:

1. From the Database window, click Forms under Objects.

2. Click the form you want to open.

3. Click the Open button to open the form in Form view, or the Design button to open the form in Design view.  Once you've opened a form, you can easily switch among the three views of the form by clicking the View button on the toolbar.



	WORKING WITH REPORTS
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	Instructor Guidelines
Provide the following key points about Access report generation.

· Generating a report allows you to present your data in a printed, organized format.  You can design the report so that only the information you want included is generated.

· AutoReport:  The easiest way to create a report is to use the AutoReport feature.  AutoReport will create a report that will include all fields and records in the underlying table or query.

· Report Wizard:  Report Wizard easily creates a report based on the database objects you have built.  You will determine the report options by answering questions when prompted by the Report Wizard.

· Formatting the Report:  All changes to the report design will need to be done using the Report Design view.
· Using the Report:  When opening a report, the only thing you can do is view the report, you cannot make changes to the design or the data contained within the report.  Use the Report Design view to change the design of the report.  To change the data, you will need to open the table or form.
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	Instructor Checklist

AutoReport

Provide the steps below to create a report using AutoReport.

To create a report using AutoReport:

1. From the Database window, choose Reports under Objects.

2. Click the New button.

3. In the New Report dialog box, click one of the following wizards: 

· AutoReport:  Columnar—Each field appears on a separate line with a label to its left.

· AutoReport:  Tabular—The fields in each record appear on one line, and the labels print once at the top of each page. 

4. Click the table or query that contains the data you want to base your report on.

5. Click OK. 
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	Instructor Checklist

Report Wizard

Provide the steps below to create a report using the Report Wizard.

To create a report using the wizard:

1. In the Database window, select the Report Tab, choose Create Report by Using Design Wizard.

2. Click Preview.

3. Choose the tables and fields you want to include in the report, then click Next.

4. Add any grouping levels, then click Next.  Note:  Grouping levels allows you to group pieces of information together on a report.

5. Choose the order of how you would like records to appear on the report, then click Next.

6. Select the format for the form and choose the page orientation, then click Next.

7. Assign a style to the report, then click Next.

8. Name the report and choose how you want to view it, then click Finish.

· If you choose Preview the Report, when Finish is clicked the report will open with the defined options.

· If you choose Modify the Report’s Design, when Finish is clicked the Report Design window will open so you can modify the report design.

Formatting a Report

Provide the steps below for modifying the design of a report.

To modify the design of a report:

You can use the following techniques to customize a report that you created with a wizard or to create a report entirely on your own.  All changes to the design of the report are done in the Design view.  

1. Select formatting options, including font, size, bold/italics/underlining of text, text placement, and text color.  To change text formatting, click on the text and click on the formatting options contained in the Formatting Toolbar.

2. Add background to the report.  To change a background, click in the Design view of a report, right-click with the mouse, choose Fill/Back Color, and click on the color you want.

3. Size and align the report controls (label boxes and the text boxes where the data is stored on the report).  To size report controls, click on the control box and drag the sizing handles until the control is the size you want.  To align boxes, select multiple boxes, right-click with the mouse, choose Align, and choose the desired alignment.

4. Change data labels on the report.  To change data labels, double-click directly into a label box and edit the text.
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	Instructor Checklist

Formatting a Report

Headers and Footers

Headers and footers can be included for text and graphics that you want included on each page in the report.

Provide the steps below for creating headers and footers in a report.

To add or remove a report header and footer or a page header and footer:

1. Open the report in Design view.

2. Click Report Header/Footer or Page Header/Footer on the View Menu. 

3. Key in the text you want to appear.

Predefined Reports

The report can be automatically generated using predefined formats.

Provide the steps using pre-defined formats in a report.

To format a report by using predefined formats:

1. Open a report in Design view.

2. Do one of the following:  If you want to format the entire report, click the report selector.  If you want to format a particular section, click the section selector.  If you want to format one or more controls, select the controls. 

3. Click AutoFormat [image: image5.bmp] on the toolbar.

4. Click one of the formats in the list and choose any options.

Using a Report

Provide the steps below for opening the report.

To open a report:

1. From the Database window, click Reports under Objects.

2. Click the report you want to open.

3. Click the Preview button to preview the report, or the Design Button to open the report in Design view.



	WORKING WITH QUERIES
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	Instructor Guidelines
Point out the following key points for working with queries.
· A query is a question you ask Access about your data.  Microsoft Access gathers the data that answers your question and displays it in a separate output.  Queries allow you to view one or more pieces of data in a snapshot and view only the data that you identify.  

· Select Query:  A select query is the most common type of query.  It retrieves data from one or more tables and displays the results in a datasheet where you can update the records (with some restrictions).  You can also use a select query to group records and calculate sums, counts, averages, and other types of totals.

· Crosstab Query:  A crosstab queries calculate a sum, average, count, or other type of total for data that is grouped by two types of information—one down the left side of the datasheet and another across the top.

· Running a Query:  When you open a query from the Database window, the query will automatically open and run with the most current data.
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	Instructor Checklist

Select Query 

Provide the steps below for creating a select query.

To create a simple select query with a wizard:

The Simple Select Query Wizard creates queries that retrieve data from the fields you specify in one or more tables or queries.  Depending on what you want, you can ask the wizard to perform such functions such as calculating sums, counting, and determining average values for groups of records or all records. 

1. From the Database Window, click Queries under Objects, and then click Create Query by Using Wizard.

2. Click Open.

3. Choose the name of the table or query you want to base your query on, then select the fields whose data you want to retrieve, then click Next.

4. Choose your summary options, then click Next.

5. Name the query and choose how you want to view it, then click Finish.
· If you choose Open the Query To View Information, when Finish is clicked the query will open with the set criteria.

· If you choose Modify the Query’s Design, when Finish is clicked the Query Design window will open so you can modify the query criteria.
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	Instructor Checklist

Crosstab Query
Provide the steps below for creating a crosstab query.

To create a crosstab query using a wizard:

Crosstab queries calculate a sum, average, count, or other type of total for data that is grouped by two types of information—one down the left side of the datasheet and another across the top.

1. From the Database window, click Queries under Objects, and then click New on the toolbar.

2. In the New Query dialog box, click Crosstab Query Wizard.

3. Click OK.

4. Choose the table (or another query) that contains the data you want to run for the query, then click Next.

5. Select the heading rows, then click Next.

6. Choose the functions you want performed, then click Next.

7. Name the query and choose how you want to view it, then click Finish.
· If you choose to open the query to view information, after clicking Finish the query will open with the set criteria.

· If you choose to modify the query’s design, after clicking Finish the Query Design window will open so you can modify the query criteria.
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	Instructor Guidelines
· Filtering Data:  Data can be filtered.  Filtering data allows you retrieve a subset of records from an underlying table or query.  Using a filter is easier and less time consuming than using a query, but filters cannot be saved for later reference.  A filter can be done in a table, query, or form.

· Sorting Data:  You can do a simple sort of your data.  A simple sort puts records in order by one field in ascending or descending order.

· Spell Check:  You can check your data for spelling errors using the spell check included in Microsoft Access.  Spell check can be run in either the table or the form.  The data generated in a report or query will be based on the text included in the table or form so be sure that the spelling is correct before creating reports or queries for print.
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	Instructor Checklist

Filtering Data 

Provide the steps below for using a filter.

To filter data in a form:

1. From the Table Datasheet window, click the Filter by Form ([image: image6.wmf]) icon, or select Records/Filter/Filter by Form.

2. Click the field where you want to specify the criteria for the filter.

3. Select the criteria using the drop-down list.

4. Click the Apply Filter/Remove Filter ([image: image7.wmf]) icon, or select Filter/Apply Filter/Sort.

Sorting Data 

Provide the steps below for sorting data.

To sort data:

1. From the Database window, click Tables under Objects, then select a table.

2. Click Open.
3. From the open table, click in any cell in the column you want to sort.

4. Click on the Sort Ascending ([image: image8.wmf]) or Sort Descending ([image: image9.wmf]) icon.
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	Instructor Checklist

Spell Check
To check the spelling of data in datasheet view:

1. From the Database window, click Tables under Objects, then select a table.

2. Select the records, columns, fields, or text within a field whose spelling you want to check. 

3. From the Tools Menu, choose Spelling. 

4. When a possible spelling error has been detected, correct the spelling by choosing one of the recommended suggestions or by keying in new text.  Go through each error until you have made all corrections.
5. When the spelling check is complete, it will automatically close.

To check the spelling of data in form view:

1. From the Database window, click Forms under Objects, then select a form.
2. Select the records, columns, fields, or text within a field whose spelling you want to check. 

3. From the Tools Menu, choose Spelling. 

4. When a possible spelling error has been detected, correct the spelling by choosing one of the recommended suggestions or by keying in new text.  Go through each error until you have made all corrections.
5. When the spelling check is complete, it will automatically close.




	HANDS-ON PRACTICE



	

	Have the students practice the concepts presented in this session.  Tell the students that they can refer to their User’s Guide to help them work through the steps.  Provide the instructions below.  Walk around the room and give one-on-one instruction to those who require additional assistance.  Allow 25 minutes.

Student Instructions

1. Create an address table using a blank database.  

2. Create a form.  Using the form, input the following data.

Name



Address




City



State

ZIP
Johnson, Jim         
7867 Farragut Drive 

Clarksburg

WV


86788

Martinique, Thomas
5544 Widewater Court
Providence

MD


98076 

Doe, John


5 South Wind Avenue

Springfield

MN


24354

Smith, Susan


5786 Berry Street


Longhorn

VT


78654

Miller, Robert         
558 Windover Avenue 
Clarksburg

WV


86788

Jones, Bryan         
3435 Stateroom Road      
Harpoon


VA 


22553

Frank, William

456 Stone Drive


Providence

MD


98076 

Tiller, Bonnie

332 Drake Avenue

Providence

MD


98076 

3. Enter in the following respective phone numbers using a form attached to the address table.

Name







Phone Number
 

Johnson, Jim         




244-877-5465 



Martinique, Thomas




545-871-5511
 

Doe, John






369-876-9521



Smith, Susan






524-553-6922



Miller, Robert         




244-568-9873 


Jones, Bryan         




713-583-6497 

Frank, William





644-553-8258
 

Tiller, Bonnie





644-663-8525
 

4. Create a simple query for the ZIP code 86788.

5. Design and print a report combining the two tables.
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